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Chapter 1. Installation and settings 

 

1.1 Confirmation before installating 

 

Please check below components for easy installation. 

 

① S/W CD, USB Type Dongle (care of loss) 

 

② Option 

    Camera for microscope, inter space card, cable 

 

 

Check 

 

※ Please check connection of camera cable to computer. 

   - If camera cable wouldn’t be connected to computer, can’t acquire images. 

 

※ Please check installation of camera driver and S/W. 

   - All cameras are available to this program after installation of device driver. 

 

※ Please check lever of light path of microscope body. 

   - There are three observation mode of naked eye, camera, both as the position for light path of microscope, 

if light source condition to be naked eye, you couldn’t capture images. 

 

 

Lever of light path (There’re differences by microscope manufacturer.) 

 

Naked eye 

Both 

Camera 
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The position of light path 

 

 

 

Light path of up right/inverted microscope and the position of C-Mount Adapter 

 

 

Caution 

 

Please check below to operate ARM series. 

This will help to operate ARM quickly and easily.  

And it may helpful if you have trouble in installation later. 

 

- ARM series recommend to use operating system more than Microsoft Windows XP Professional. 

 

- For the maximum usage of camera function, built-in graphic card is not recommended. 

 

- For copy protection, S/W provide Dongle (USB Type). 

 If you lost, it couldn’t be supplied again, so needed to be careful. 

 

      

 

  

 

 

USB Dongle                      
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1.2 Instruction of ARM(Advanced Real Time Monitor) 

 

ARM Series is image analysis S/W for microscope. 

With easy use of GUI(Graphic User Interface)way, supporting digital camera function to be connected 

microscope system, it can increase the efficiency of image analysis for microscope. 

 

GUI(Graphic User Interface)? 

This is working environment that user can exchange computer with information with graphic. Text-based user 

interface performed the operation with command from keyboard and displayed character on the monitor. But 

graphic-based interface with mouse orders working with choice of one menu on the screen. 
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1.3 Guides for installation 

 

After install the camera device driver connected microscope system and continue installing as below. 

① Install USB dongle key driver 

After install ARM, insert CD and install USB dongle key, practice the installation file on the inside of CD-

ROM disk. 

*Before installation of driver, when installating dongle key, please close ‘installation wizard’ with click 

‘cancle’ button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

* Click ‘Next’ button in the dialog box after running files, and select comb box of ‘service agreement’. 

* After selecting ‘service agreement’ comb box, if you click ‘Next’ button, driver will be installed 

automatically. 

* If USB dongle key driver is not installed normally, below message box will be printed out. 

 

 

 

 

 

 

Error message of running program with bad condition of installating USB dongle key 
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② Installation of ARM S/W  

Run below installation file on the inside of CD-ROM disk after completing installation of USB dongle key 

driver. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

* Click ‘Next’ button in message box printed after running file. 

* Click ‘Installation’ button in message box printed after clicking ‘Next’ button. 

* S/W installation will be running automatically after clicking ‘Installation’ button. 

* Check the creation of icon after completing installation of S/W. 

 

 

 

 

 

 

ARM running icon 

 

 

 

Double Click 
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1.4 Guides for setting camera and measure 

 

ARM Series is compatible with AcquCAM series of JNOPTIC and standard camera with basic window 

supporting WDM(Windows Driver Model). 

If you have cameras for microscope, please feel free to ask JNOPTIC for further question of compatibility. 

 

① Camera recognition 

In condition of completion of installation for device driver of microscope camera and to be connected to 

PC, you can check the device name on the icon bar without specific device option and activated device 

list including using button after installation ARM Series. 

 

 

 

 

 

 

* EX 1) Activated camera icon bar after connection camera and installation of driver 

 

 

 

 

 

*EX 2) Un-activated camera icon bar in case of disconnection of camera (unable to output image) 

 

 

After completion of installating camera well like EX 1), click live button and check the monitor is output 

normally on the ARM start-up screen. 

 

 

 

 

 

Click live button and check the output image. 
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② Start-up screen 

If the installation of camera device driver for microscope will be completed, you can check live image on 

the first running page without additional setting. And please proceed below caution. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ARM first page 

 

 

※Caution – After completing installation ARM S/W, please assign folder to save taken pictures 

with *auto save setting menu refer to this manual 2.1 Camera. 

 

 

 

 

 

 

Assign page of auto save image folder (Refer to 2.2 section) 
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③ Microscope calibration 

Calibration is essential to get more exact date than the measured image saved on ARM program with  

real microscope image. 

* Preparing sample with objective micrometer and click (   ). 

 

1) Click File->Option->Calibration on the menu. 

 

 

 

 

 

 

 

 

 

 

 

2) Click ‘New Preset’ button on the active calibration menu page. 
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3) On active ‘Preset information’ tab, input lens magnification be set in microscope. 

 * If lens magnification be set in microscope is 20, input 20X or 20 (Same name, magnification) 

* For Unit, set the ‘um’ excluding special case. 

 

 

 

 

 

 

 

 

 

 

 

 

4) Input the length to be seen on the monitor, and click ‘Calibrate’ button. 

* If the length of sample available for measurement on live is 600um, input ‘600’. 
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A B 

5) After click ‘Calibrate’ button, if the option box will disappear, click start point(A) and end point(B) of 

4) input date, 600um to be seen on the monitor. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6) After measuring sample image, if the option box will appear again, click ‘Save Preset’ icon and save 

present calibration data. 

 

 

 

 

 

 

 

 

 

 

 

* If the calibration of one magnification is completed, this magnification will be saved on preset box 

on the left. 

* Repeating process 1~6 by type of lens in microscope, calibration will be completed. 

 



 

ARM Manual  13  of  33 

 

 

Chapter 2.      Usage of ARM  

2.1 Camera 

 

It’s need to operate live image and capture images as wanted type. 

* You can see camera icon bar only live camera mode. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

* Save image automatically 

Save image consecutively 

Stop image, save automatically 

Stop image 

Live image 
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* Information of icon for option 

 

 

 

 

 

  

 

 

 

* Setting menu for save automatically 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

save image automatically 

File name of automatic image 

Type of file name 

File format 

Time gap of series picture 

Count of series picture 

Include measuring data or not 

Select camera Set resolution Set camera details 
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2.2  Basic function 

 

This is the basic function of program for saving and opening the document. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Page setting 

Print 

 
Save other name 

 
Save 

 
Open 
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2.3 Screen layout 

 

There are basic and simple icons like as save, open for easy use of S/W. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Enlarge / Reduce 

Full screen 

 
* Image effect 

 
* Show last capturing 

* Image thumbnail 

* Show data sheet 

If the icon of * Show measuring date sheet and * Image thumbnail is active, you can see below 

tab on the left bottom on the monitor. With selecting tab, you can move anywhere you want. 
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* Measuring data sheet menu 

 

After capturing images, you can see each measuring data on the data sheet menu. 

And you can save, adjust data for excel sheet. 

 

 

 

 

 

 

 

 

 

 

 

 

Window of measuring data sheet 

 

 

* Image thumbnail 

 

This is the window to check page preview for capture image. 

If you acquire image with pressing    button or F11, page preview is available because image 

accumulated on the thumbnail list. 

 

 

 

 

 

 

Image thumbnail window 

 

Create excel sheet for accumulate data Delete measuring data 
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* Watch the last shooting image 

 

This is the function to check the last shooting image. 

If there’re many shooting images, this is useful to check the last image and to assort the sample of 

same pattern. 

If use dual monitor, you can compare and watch with drag last screenshot window to secondary 

monitor. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Window of last shooting image 
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* Image effect 

 

This is the function to emphasize image and to change colors with applying specific effect on capture 

image. 

Selecting the effect you want with click of mouse, and setting value, click this (    ), it can affect 

image.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Adjustment of image effect 

 

 

 

 

 

 

 

Reversal of image 

Grayscale 

User-defined color 

Control of gamma  

Control of brightness 

Control of contrast 

Control of saturation 
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2.4 Measurement 

 

This is basic icon to measure length, angle, basic items ARM provides. 

Proceed with choice of measurement items after capturing images. 

 

 

                                                                             *Before measurement, refer to  

the 2.6 setting of magnification 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Measure area of two points 

Measure area of square 

Measure area of triangle 

Measure angle 

Measure length 

Hand-operated counting 

Selection of objects 

Measure area of three points 

Measure area of polygon 
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2.5 Others 

 

They are necessary icons for using program of standard setting and guide line of lay out setting. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Guideline of color 

Guideline of scale 

Guideline of cross 

Remove guideline 

Standard setting 
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2.6 Scale bar and magnification setting icon 

 

By combo box existed in icon bar, you can adjust the position of scale bar and set the magnification. 

You can get exact data, if you set the magnification of real shooting objective lens and icon before 

measuring image. 

 

 

 

 

 

 

 

 

  

 

 

 

 

  

 

 

Positioning scale bar 

Magnification setting icon (set equally live and pause-image) 
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2.7 Image composition 

 

You can make images of individual channel one image with ARM function of image composition if you 

use florescence microscope and camera. 

 

* Below sample images are the example after compositing with capture images by R, G, B 

channel. 

 

1) Image acquisition of florescence image by channels. 

 

Before using the composition function, by using wavelength filters for each channel, you can shoot pictures or 

open images. 

 

 

 

 

 

 

 

 

               Red                           Green                          Blue 

 

 

 

 

 

 

 

 

 

If you acquire images by channel or open saving images, image lists including live camera in image butter tap 

will activated.    
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2) Menu of image composition. 

 

After completing of acquisition for images to composite, click text menu ‘Tools -> Merge Images’ and invigorate 

composition menu. 

 

 

 

 

 

 

 

 

If menu of image composition is activated, saving images in tap or thumbnail will activated in ‘Image Sources’ 

and with double-click, add ‘Selected Images’. 

To add in ‘Selected Images’, over two images are needed. 

 

 

 

 

 

 

1. Select the position to save image 2. Double-click to compose images (over two) 
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After adding images to compose, click (    ) in Target Filename and click ‘OK’ button after selecting save path, 

name, image format(BMP, JPG etc,.). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After above process, image file and tap will be created like below. 

 

 

 

 

 

 

 

 

 

Composite florescence image

1. Check image list to be added 3. Confirm 2. Select save path of images 
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3) How to create color composite image 

 

In case of shoot florescence image, it’s general to acquire black images by channel with Mono camera be highly 

sensitive but you can acquire color composite images to apply temporary color to each channel. 

 

After activate image to apply temporary color, click one image effect icon (    ) of *2.2 items and proceed 

below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After completing choice of color and apply to the image with click icon (    ).  

 

After completion of setting with reference for channel color of each image, below images to have each color are 

created. 

 

 

 

 

 

 

 

              Red                         Green                         Blue 

1. Check box of select colorize 2. Click icon of gear shape 

 

3. Choice of color to apply to the image in the temporary color chart and O.K. 
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After activate temporary color images to need composite in tap or thumbnail and proceed *No. 1) ~2) of 2.7 

list, color florescence images are created. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Compose of color florescence image is completed 

 

 

 

2.8 Text menu 

 

 

 

 

* Text menu of ARM is linked with icon menu so, you can use almost every functions by using only 

icon menus.
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2.9  JNO-MHU (Measuring height unit) linkage and instruction 

 

Refer to below linkage and instruction if you are using measuring z-axis heigh unit, JNO-MHU of JNOPTIC. 

 

 

 

 

 

 

 

 

JNO-MHU 

① Installation of device driver 

 

1) Insert ARM installation CD. 

 

2) If USB device is connected, click ‘my computer’ icon-> right mouse click-> ‘attribute’ -> ‘device 

manager’(If window is below XP version, you can check in hardware tap) and you can see ‘USB serial 

port’ in ‘other device’ and click ‘driver software update’ with right mouse click.  

 

 

 

 

 

 

 

 

Device Manager 

1. Right mouse click 

2. Update menu click 
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3) Click ‘searching for driver software in computer’ in update box.  

 

 

 

 

 

 

 

 

 

 

Update box 

 

4) If below box is screened, click ‘searching’ and designate folder name like JNO-MHU Device driver” and 

click ‘next’.  

EX) “D\06_ARM_Live Image Analysis Software\03_JNO-MHU Device driver” 
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5) If the security message is screened, check ‘~ reliable software’ in check box and click installation 

button. 

 

 

 

 

 

 

 

 

Security message box 

 

6) If the completed message of device driver is screened, close the box and check again ‘device driver’ 

and confirm the new created list of ‘USB Serial Port(COMX)’ in Port(COM & LPT)’. 

 

 

 

 

 

 

 

Device manager list after completed installation of device driver properly 

 

7) Click ARM software and click “File” -> “Options” -> “JNO-MHU” menu. 
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8) if “frmComOption” box is shown, check “Enable JNO-MHU” in the check box, and click “Scan”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

JNO-MHU 설정창 

 

9) If “device detected” box is show after recognition of device, click “confirm” for completion of 

installation and check the Z-axis position value is equal to JNO-MHU. 

 

 

 

 

 

 

 

 

 

 

  Message of recognition of device           The value of Z-axis on the live screen 
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③ Instruction of JNO-MHU 

 

1) Explanation of linkage JNO-MHU 

 

 

 

 

 

 

 

 

 

 

 

* If the screen of linkage with JNO-MHU is red, this is the alarm message for “Backlash” because of 

sudden operating. So you’d better adjust fine/coarse focus know slowly. 

 

2)How to reset Z-axis value(set-up starting point) 

 

To reset Z-axis value to ‘0’, use “Reset controller button” or “Space bar” of keyboard. 

 

 

 

 

 

 

 

 

 

 

 

 

Reset controller button 

 

Resetting direction JNO-MHU Power-on 

Z-axis value Direction of fine/coarse 

now조정방향 
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Chapter 3. FAQ 

 

3.1 FAQ 

 

Q) Program is not running. 

 

A) – USB dongle for copy protection is in USB port? 

 

Q) The icon printout images is deactivated and images are not displayed. 

 

A) – Camera USB cable is connected with PC? 

   - Camera driver is installed on PC? 

(You can check whether or not camera driver is installed in ‘device manager’.)  

   - Camera name displayed on the input device setting is same with the camera name connected to microscope? 

 

Q) Monitor screen is displayed black 

 

A) – light path lever of microscope is to camera image? 

 

Q) With click of CAPTURE IMAGE icon, images are not saved. 

 

A) – Refer to 1.4 caution (page 8) 

 

If you have any more questions, please feel free to contact below. 

 

Company : JNOPTIC CO., LTD. 

Add : #203, 129-Gil, Dongil-Ro, Jungnang-Gu, Seoul, Korea 

Tel : 82-2-3473-4188 

H.P : http://www.jnoptic.com 

E-mail : jhjin@jnoptic.com 

mailto:jhjin@jnoptic.com

